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Chapter 1
Introduction to the ECAD-MCAD

Collaborator

The ECAD-MCAD Collaborator is an application that facilitates the exchange of PCB layout
and mechanical data between a designer using Expedition PCB, Board Station XE or PADS
(from Mentor Graphics) and a designer using a third party mechanical design application such
as PTC Pro/Engineer. This chapter provides the following information:

• Introduces the ECAD-MCAD Collaborator application by explaining the need for
collaboration and how ECAD-MCAD Collaborator serves that need.

• Explains the differences between the basic 3D PCB Viewer and the 3D PCB Viewer
augmented with ECAD-MCAD Collaborator functionality.

• Describes how to launch the ECAD-MCAD Collaborator application.

Collaboration Between PCB Layout and
Mechanical Design Organizations

Every PCB design is at least in part driven by the mechanical aspects of the product for which it
is being designed. The shape of the board outline, locations of mounting holes, connectors,
switches, and so on, are constrained by the system or enclosure in which the PCB will be
mounted.

The ECAD (Electronic Computer Aided Design) and MCAD (Mechanical Computer Aided
Design) groups might be working on the same product, but creating PCB and mechanical
designs independently from each other. These ECAD and MCAD groups could be co-located,
separated by several time zones, and might not even be part of the same company. Over the
product development period, it is very likely that either organization might need to make
changes to their design that could impact their counterpart organization. Prompt understanding,
communication, and agreement of such changes becomes important in managing development
costs, and to the overall success of the product.

Today, communication methods used to explain and adopt such changes are often limited to e-
mails, phone conversations, and marked up drawings. These methods are sometimes inefficient
and can lead to mis-communication and confusion, resulting costly errors later in the
manufacturing process. To solve these problems, the Mentor Graphics ECAD-MCAD
Collaborator provides an application and user interface that engineers in both organizations can
use to capture and collaborate on minor iterations and changes in the design that could
potentially affect design parameters in the other organization.
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How ECAD-MCAD Collaborator Integrates into the Design
Process

To facilitate data exchange, both the PCB layout group and mechanical design group must be
able to see the impact of the change. To visually represent the design and any proposed changes,
the ECAD-MCAD Collaborator uses the base 3D viewing capabilities present in the Mentor
Graphics 3D PCB Viewer application. The 3D PCB Viewer application must be installed to run
the ECAD-MCAD Collaborator software.

Once installed, the ECAD-MCAD software augments the viewer with additional features that
allow the viewing of incremental changes within a PCB layout or mechanical design and the
creation and management of change requests between organizations. In a Collaboration session,
one designer can make changes in the design system that are then captured and displayed by the
Collaborator. At that point, the proposal can be shared with a second designer (either through a
shared directory or via e-mail) for consideration and feedback.

The 3D PCB Viewer window of the ECAD-MCAD Collaborator allows a user to see the impact
of change from many different perspectives in two or three dimensions. The collaboration
features let users propose change requests resulting from minor changes in the design, view and
understand the scope and impact of a such a change to the corresponding organization, review
change requests, accept or reject change requests, and manage change request queues.

Data Exchange Format
The Collaborator is designed so that ECAD and MCAD designers can work in their own design
environments, but still communicate text and graphics transactions back and forth quickly and
cleanly. The graphics that are transmitted are only those required to adequately communicate
the desired change, and are only a subset of the actual design data.

The application exchanges incremental data between ECAD-MCAD Collaborator sessions
using an XML format that follows the new ProSTEP iViP recommendation based on ISO
standard 10303. The ProSTEP iViP Association is a consortium of member companies
recommending non-proprietary standards for the exchange of ECAD and MCAD collaborative
data.

Because the transmission and format of data between ECAD-MCAD Collaborator sessions is
largely transparent to users of the ECAD-MCAD Collaborator application, this manual does not
discuss the actual format of transmitted data. However, details on the ProSTEP iVIP
ECAD/MCAD Collaboration recommendation is available by visiting
http://www.prostep.org/en/.
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Differences between ECAD-MCAD Collaborator and 3D
PCB Viewer

The ECAD-MCAD Collaborator user interface relies on the Mentor Graphics 3D PCB Viewer
software to provide the functionality to display a visual 3D representation of the circuit board,
but with several additions to assist ECAD and MCAD designers to initiate collaboration
sessions, propose changes, and accept/reject proposals. The resulting ECAD-MCAD
Collaborator interface contains the primary viewing features found in the standard 3D PCB
Viewer application, but augments the 3D PCB Viewer interface with the following added
functionality (Figure 1-1):

• An EDMD tab in the display control area with collaboration-specific items.

• A Collaborate pulldown menu item with several collaboration menu items.

• A Collaborate toolbar with icons corresponding to Collaborate pulldown menu items.

• Enhancements to the graphical viewing area to highlight an object affected by a change.

Figure 1-1. ECAD-MCAD Collaborator User Interface

This manual only discusses the features unique to the ECAD-MCAD Collaborator. For
information about the viewing features found in both the ECAD-MCAD Collaborator and 3D
PCB Viewer products, refer to the 3D PCB Viewer User’s Guide.
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Collaboration Process Flow
The general steps of the collaboration process flow follows the items on Collaborate > Actions
pull-down menu (Figure 1-2).

Figure 1-2. Collaborate > Actions Pull-down Menu

Each menu item in the Actions submenu performs a specific request-related action. The
following lists the high-level steps in the collaboration process when using the ECAD-MCAD
Collaborator application:

1. Both collaboration parties open the design tool on the design under consideration and
then launch the ECAD-MCAD Collaborator from that design tool. In the collaboration
session, one person takes on the role of the change initiator, while the other person takes
on the role of the change recipient.

Your collaboration role determines which change request actions are pertinent. In
Figure 1-2, the change initiator uses the top two menu items, while the change recipient
uses the bottom three menu items. The arrows indicate the order in which the menu
items are executed for a particular change request.

2. After setting up the session, the initiator uses the Send Change Request menu item to
create one or more proposed change requests. The ECAD-MCAD Collaborator treats
each change request as a transaction that requires a response from the request recipient.

The ECAD-MCAD Collaborator requires completion of the transaction cycle for a
single change request before allowing another change request to be sent.

3. The recipient uses the Show Change Request menu item to view the proposed change
request and see a summary in ECAD-MCAD Collaborator of how the proposed changes
affect the design.

4. The recipient uses the Validate Change Request menu item to send the changes to the
design open in the parent application, where more extensive checks can be run to
evaluate the changes within the context of the actual design.

5. After evaluating the changes, the recipient uses the Send Response menu item to send a
response back to the initiator listing which changes in the change request are acceptable
and those changes that were rejected.
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6. The initiator uses the Process Response menu item to process the recipients response
and close the transaction.

7. After reaching an agreement, both the initiator and recipient update their designs with
the changes that were acceptable. For those changes that were rejected, the initiator can
decided whether or not to generate a new change request with a different proposed
solution.

8. When both parties are satisfied with the changes and have incorporated all agreed up
changes, they then close their respective ECAD-MCAD Collaborator sessions.

Chapter 3 “Using the ECAD-MCAD Collaborator” provides detailed instructions to perform
each step in the process flow.

Graphically Showing Request States
Both parties in the collaboration session can use the Collaborate > Display Requests pull-
down menu items (Figure 1-3) to view the status of requests in the graphic area of the ECAD-
MCAD Collaborator. Chapter 3 “Using the ECAD-MCAD Collaborator” provides detailed
information about how to use the menu items in Figure 1-3.

Figure 1-3. Collaborate > Display Requests Pull-down Menu

An Example Use Case
The following steps and Figure 1-4 describe an example how an ECAD designer and MCAD
designer might use the ECAD-MCAD Collaborator in a collaborative session:

1. Due to an enclosure change, the MCAD designer needs to move a mounting hole. In a
collaboration session, the MCAD designer uses the ECAD-MCAD Collaborator to
transmit a new mounting hole location suggestion to the ECAD designer.

2. The ECAD designer evaluates the change and determines the re-layout would be too
extensive. The ECAD designer rejects the change and suggests a new alternative
mounting hole position.

3. The MCAD designer reviews the suggestion in their design system and finds it
satisfactory. The MCAD designer uses the ECAD-MCAD Collaborator to send the
acceptance back to ECAD.
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4. Both the ECAD designer and MCAD designer update their designs.

Figure 1-4. An Example Collaborative Use Case

Launching the ECAD-MCAD Collaborator
Note
The ECAD-MCAD Collaborator must be installed in the same directory as other Mentor
Graphics products.

From Expedition PCB or Board Station XE, launch ECAD-MCAD Collaborator using the ECO
> EDMD Collaborator pull-down menu item. To launch EDMD from PADS, choose Tools >
EDMD Collaborator pull-down menu item.

The ECAD-MCAD Collaborator maintains a connection with the launching application so that
any changes made in Expedition PCB or Board Station XE are then captured, as explained in
Chapter 3.

Incase Expedition is in the variant view when attempting to invoke ECAD-MCAD
collaborator, the menu to invoke the ECAD-MCAD collaborator is disabled to prevent any edits
to Expedition from ECAD-MCAD collaborator. Furthermore, the collaborator tool bar is
disabled and any send or apply change action from the collaborator dialogs is prevented if
Expedition was switched to the Variant view during a collaboration session.
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In the case of Board Station XE, the ECAD-MCAD collaborator menu is only enabled when
import of board geometry edits is not allowed and editing of board geometry elements is
allowed.

Every BSXE design has a bsxe_data_mapping.ini file in the pcb folder “<Design>/pcb”. This
file contains options for generating the XE database. The two keywords that control the board
geometry elements are:

• MGC_UPDATE_FROM_BOARDGEOM: Specifies whether to import board geometry
edits into BSXE or not. Its default value is “yes”.

• MGC_ALLOW_EDIT_BOARDGEOM_ELEMENT: Specifies whether to allow
editing board geometry elements in BSXE or not. Its default value is “no”.

For enabling EDMD collaboration, it is mandatory to set them to:

• MGC_UPDATE_FROM_BOARDGEOM = no

MGC_ALLOW_EDIT_BOARDGEOM_ELEMENT = yes

When EDMD Collaborator application is up and running through PADS some activities are not
allowed in PADS Layout. This includes:

• Running the File/New command

• Deleting Board Outline (Delete, Cut commands)

• Running the Save As command

• Running the Decal Editor

• Switching to Router (using Route button on Standard Toolbar or by using Tools/PADS
Router… command)

• Changing on-line DRC mode

Each attempt to perform a restricted activity will result in an error message:

"This activity is restricted during EDMD collaboration session".

Prerequisites & Limitations
There are some prerequisites & limitations that should be taken into consideration before using
the ECAD/MCAD Collaborator tool. These prerequisites & limitations are:

• Only one board object and one route keepin are allowed. These objects can never be
deleted. The route keepin can only span all layers.

• Library data is not editable. The holes & mechanical cells can be added, but electrical
cells can not be added.
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• Generally, cutouts in shapes are ignored.

• Only a component shape is used to define a cell. Components do not contain pins, holes
or nested cells.

• Only a hole shape is used to define a hole. The hole’s shape is limited to round holes so,
holes of other shapes are ignored. The hole definition is just the hole with a plated flag.
There are no pads or other attributes.

• Groupings of objects are ignored.

Caution
The ECAD and MCAD library data must be in sync. The component shapes must be
similar, have the same origin and orientation. If not, then apparent incorrect component
placements will occur even on the top of the board.

Limitations for the PADS 9.3 flow
The scope of data exchanged between ECAD and MCAD systems supported in PADS 9.3
version of EDMD Collaborator is limited to:

• Board geometry - includes board outline but no board cutouts, and layer stackup
information

• Electrical Components placed on the board

• Mechanical Components placed on the board

• Mounting Holes – plated or non-plated (board-level) holes

• Single-layer Placement Keepouts (called Placement Obstructs in EDMD dialogs) – may
have height restriction
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Chapter 2
ECAD-MCAD Collaborator Quick Reference

The ECAD-MCAD Collaborator provides many different ways to execute the same commands:

• Pulldown menus

• Toolbar Icons

• Tabbed Sheet Items

This chapter summarizes each of the commands, icons, or tabbed sheet items and the tasks they
perform in the user interface.

Pulldown Menus
Figures 2-1 and 2-2 show the pulldown menu items associated with collaboration tasks.

Figure 2-1. Collaborate > Actions Pulldown Menu Items

Figure 2-2. Collaborate > Display Requests Pulldown Menu Items

Toolbar
Figure 2-3 shows the ECAD-MCAD Collaborator tool bar.
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Figure 2-3. ECAD-MCAD Collaborator Toolbar

Command Summary
Table 2-1 provides a summary of ECAD-MCAD Collaborator commands and the tasks they
perform.

Table 2-1. ECAD-MCAD Collaborator Commands

Menu Command Function Icon

Collaborate > Actions > Send
Change Request

Displays the Send Change Request dialog box
that a change request initiator uses to create a list
of proposed changes and encapsulate them into a
change request file.

Collaborate > Actions >
Process Response

Displays the Process Response dialog box that a
change request initiator uses to view and process
the accept/reject response from the change
recipient.

Collaborate > Actions >
Abandon

Allows you to return back from the process
response state to the state before which the
message was sent.

Collaborate > Actions > Show
Change Request

Displays the Show Change Request dialog box
that a change request recipient can use to view
the contents of a change request file and
graphically display an individual proposed
change on the 3D view of a design.

Collaborate > Actions >
Validate Change Request

Incorporates the change into the design displayed
in the parent application so that the change can
then be validated for acceptance or rejection.

Collaborate > Actions > Send
Response

Displays the Send Response dialog box that a
change request recipient can use to accept or
reject individual changes that are part of the
request.

Collaborate > Display
Requests > Accepted Changes

Displays the changes accepted by the request
recipient in green in the graphic area.

Collaborate > Display
Requests > Rejected Changes

Displays the changes rejected by the request
recipient in red in the graphic area.
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Collaborate > Display
Requests > Changes To Be
Sent

Displays changes to the design in yellow in the
graphic area that are captured in a pending
change request but have not yet been sent by the
change initiator.

Collaborate > Display
Requests > Changes Sent

Displays changes that have been sent to the
change recipient by the change initiator, but not
yet acted upon, in green in the graphic area.

Collaborate > Display
Requests > Changes To Be
Evaluated

Displays changes that the change recipient has
viewed, but not yet evaluated.

Collaborate > Clear Graphics Clears any colored highlights from the graphic
area.

Collaborate > Setup Displays the Setup parameters dialog box with
which to configure the ECAD-MCAD
Collaborator session and designate yourself as a
change request initiator or a change request
recipient.

None

Table 2-1. ECAD-MCAD Collaborator Commands (cont.)

Menu Command Function Icon
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Chapter 3
Using the ECAD-MCAD Collaborator

This chapter provides the procedures to use the ECAD-MCAD Collaborator application in a
collaborative session.

Invoking the ECAD-MCAD Collaborator
Perform the following steps to invoke the ECAD-MCAD Collaborator:

1. Contact the party with which you want to collaborate (usually by telephone, email, or
internet messaging) indicating your desire to have a collaboration session on a particular
PCB layout or mechanical design using the ECAD-MCAD Collaborator.

2. If the design is for a PCB layout, open Expedition PCB or Board Station XE on your
local copy of the design.

If the design is for a mechanical enclosure or construction, open the mechanical design
application on the design.

3. From within Expedition PCB or Board Station XE, choose the ECO > EDMD
Collaborator pull-down menu item. To launch EDMD from PADS, choose Tools >
EDMD Collaborator pull-down menu item.

Incase Expedition is in the variant view, the menu to invoke the ECAD-MCAD
collaborator is disabled to prevent any edits to Expedition from ECAD-MCAD
collaborator.

For information about invoking the ECAD-MCAD Collaborator from a third party
mechanical application, refer to the documentation for that application.

Note
The Persistent.xml file is only updated when EDMD collaborator runs. It is updated
compared to the last collaboration state.
The Persistent.xml file can be found at <Design Name> > Pcb> config> Persistent.xml.

The ECAD-MCAD Collaborator session window appears as shown in Figure 3-1.
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Figure 3-1. Invoking the ECAD-MCAD Collaborator

Setting Up the Collaboration Session
After invoking the ECAD-MCAD Collaborator, both parties must choose the Collaborate >
Setup pull-down menu to display the Setup parameters dialog box (Figure 3-2) and then
complete the dialog box to specify the same collaboration method. The two methods of
collaboration are:

• Collaborating using a shared directory location that both collaboration parties can
access.

• Collaborating through email.
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The following headings explain each set up method.

Figure 3-2. Setup Parameters Dialog Box

Using a Common Collaboration Directory
To use a common directory (file-based communication) as the collaboration method, complete
the Setup parameters dialog box as follows:

1. If desired, change the name that appears in the Design Name field. The default is the
name of the design that was open in the parent application when you launched the
ECAD-MCAD Collaborator session. However, you can change the value to any name
you want to use when communicating with your collaboration partner.

2. Choose File based as the communication method.
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3. In the File Extension field, choose XML file as the type of the transaction file.

4. In the Share Path field, specify the path to a shared directory that both parties can
access. Both parties must have write access to this directory.

5. Since email is not being used as the collaboration method, leave the Sender Details and
the Receiver Details fields empty.

With the ECAD-MCAD Collaborator configured to use a common collaboration directory, both
parties must monitor the shared directory location since the Collaborator is not configured to
send automatic email when a request event occurs. That is, the request recipient must monitor
the shared directory location for new requests, and the request initiator must monitor the shared
directory for request responses.

Collaborating Through E-mail
To collaborate through email, complete the Setup parameters dialog box as follows:

1. If desired, change the name that appears in the Design Name field. The default is the
name of the design that was open in the parent application when you launched the
ECAD-MCAD Collaborator session. However, you can change the value to any name
you want to use when communicating with your collaboration partner.

2. Choose Email based as the communication method.

3. In the File Extension field, choose XML file as the type of the transaction file.

4. In the File Location field, specify the path to a local directory that can serve as a
temporary storage location as you initiate and process requests. Your collaboration
partner does have to have access to the directory you specify.

5. Since email being used as the collaboration method, complete the Sender Details and
the Receiver Details fields.

With the ECAD-MCAD Collaborator configured for email collaboration, the application sends
an auto-generated email to your collaboration partner with an attached XML file for each action
on a request. When using email-based collaboration, you must save the attachments on
incoming e-mails before you access the contents of the file in the ECAD-MCAD Collaborator.

Sending a Baseline Request
If there is no collaboration history for the design, perform the following steps to create a
baseline request and make it available to your collaboration partner:

1. In the parent application from where you launched the ECAD-MCAD Collaborator
(either Expedition PCB or Board Station XE), examine your design and perform any
changes you want to send as part of the baseline request.
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2. Choose the Collaborate> Actions> Send Change Request pull-down menu item or
click on the Send Change Request icon in the toolbar.

The below EDMD Collaborator dialog box is displayed.

3. After clicking the Yes button, the Send Change Request dialog box is displayed listing
all the uncollaborated components as potential send objects in their corresponding object
type tab. Each tab on the Send Changes dialog shows the collaboration and information
data specific to the object type it holds.

Tip: If you click the No button, no components will be displayed in the Components tab
in the Send Change Request dialog box.

4. Select the Baseline check box. Notice that the dialog’s name changes to Send Baseline
Request dialog box. Figure 3-3

Figure 3-3. Send Baseline Request — General tab

If your Baseline Request contains route obstruct of type “TraceVia”, it will be sent as
two different collaboration requests; one of type “Via” and the other of type “Trace”.
The route obstruct with type “TraceVia” will be replaced with the separate obstructs.

5. Clicking Send causes the following message to appear at the bottom of your ECAD-
MCAD Collaboration session:

Baseline sent
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An XML baseline request file is created in the directory specified when you set up the
session. Depending on how you set up your ECAD-MCAD Collaboration session, one
of two things can happen:

• If you are using file-based collaboration, the file remains in the directory as an
active request until it is viewed by your collaboration partner.

• If you are using email-based collaboration, the ECAD-MCAD Collaborator
generates an automatic email to your collaboration partner with the XML request file
as an attachment. Your partner can then save the request to a local directory before
navigating to that location and showing the request in their ECAD-MCAD
Collaborator session.

Showing and Responding to a Baseline Request
As a baseline request recipient, perform the following steps to show the contents within a
proposed baseline request:

1. If not already open, invoke the PCB layout or mechanical design application on the
design and launch the ECAD-MCAD Collaborator.

2. Choose the Collaborate > Actions > Show Change Request pull-down menu item or
corresponding icon. The Show Change Request dialog box appears.

3. In the “Transaction file” field of the dialog box, navigate to the location where XML
change files are stored and choose a <baseline_n>.xml file to open. If you are doing
file-based collaboration, this location is the file location specified in Setup parameters
dialog box. If you are doing email-based collaboration, this is the location where you
saved the request that was attached to the auto-generated email you received.

Once you have navigated to a transaction file to open, the Baseline Add Request dialog
box is displayed.

Note
If your Baseline Request contains a route border of SIDE value “TOP”, “BOTTOM” or
“INNER”, it will automatically be flagged as rejected. ONLY the value “ALL” is
acceptable.
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Figure 3-4. Baseline Add Request — General tab

You are not allowed to modify in the baseline request. If you do not accept any of the
added objects, you can simply click the Cancel button. Otherwise, click the Apply
button, the Baseline dialog box is displayed.

Figure 3-5. Baseline dialog box

4. On clicking OK, any previous collaboration history will be deleted and a new
collaboration state will be set from the baseline message. The following message
appears at the bottom of your ECAD-MCAD Collaboration session:

Baseline applied...Ready to send or receive more changes

Creating and Sending a Change Request
Now that both you and your collaboration partner have a common understanding of the design
as described in “Sending a Baseline Request” on page 22, you can perform the following steps
to create a request consisting of proposed changes and make it available to your collaboration
partner:

1. Activate the parent window from where you launched the ECAD-MCAD Collaborator
(either Expedition PCB, Board Station XE, or the third-party mechanical design tool)
and perform the action you want to capture as part of the proposed change request.
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As you perform an action in the parent application (for example, moving the location of
an uncollaborated object in Expedition PCB, the 3D Viewer window of the ECAD-
MCAD Collaborator highlights the new location in yellow. If desired, you can use the
3D Viewing capability of ECAD-MCAD Collaborator to look at the change from
several angles to make sure it is what you want before continuing to the next change.
When viewing the change in ECAD-MCAD Collaborator, the last view you display
before moving on to the next change in the parent application becomes part of the
change request. Therefore, you should also try and end with a view in the ECAD-
MCAD Collaborator that visually is best to show the change to your collaboration
partner.

2. If there is more than one change in your proposal, perform the next change in the parent
application.

3. When you have made all the proposed changes to include in the change request, choose
the Collaborate > Actions > Send Change Request pull-down menu item or click on
the Send Change Request icon in the toolbar.

4. The below EDMD Collaborator dialog box is displayed.

On clicking the Yes button, the Send Change Request dialog box is displayed listing
only the selected/ modified components as potential objects in their corresponding type
tab (Figure 3-6).

The Send Change Request dialog box lists all of the changes you just made in the parent
application that were captured by ECAD-MCAD Collaborator into the change request.

For example, Figure 3-6 shows one change -- the addition of C2001.
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Figure 3-6. Send Change Request — Components Tab

Note
New information is displayed in green, Old information is displayed in blue, Modified
information is displayed in red and data for information only is displayed in black.

Figure 3-7 shows two changes -- the addition of Mounting Holes 31167 and 34167.

Figure 3-7. Send Change Request — Mounting Holes tab

Figure 3-8 shows seven changes -- the addition of Placement Obstructs 20336, 20337,
20338, 20339, 20340, 20341 and 20342.
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Figure 3-8. Send Change Request — Placement Obstructs tab

Figure 3-9 shows two changes -- the addition of Route Obstruct 20344 of type
“TraceVia” and the addition of Route Obstructs 29120 of type “Via” and the deletion of
Route Obstruct 28141 of type “Trace” as a result of changing the type of Route Obstruct
from “Trace” to “Via”.

On sending the change request, route obstruct 20344 of type “TraceVia” will be sent as
two obstructs; one of type “Via” and the other of type “Trace” as in Figure 3-9. The
route obstruct 20344 will be replaced.

In general; route obstruct change requests are handled as follows:

a. If your change request contains route obstruct of type “TraceVia”, it will be sent as
two different collaboration requests; one of type “Via” and the other of type “Trace”.
The route obstruct with type “TraceVia” will be replaced.

b. If you change the type of a route obstruct, it will be sent as two different
collaboration requests; one as an added route obstruct “New Type” and the other as a
deleted route obstruct “Old Type”. If this request is rejected, the deleted route
obstruct will be placed back and the added route obstruct will always appear as a
potential addition in the subsequent send requests.
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Figure 3-9. Send Change Request — Board Obstructs tab

Note
Any information/ warning regarding the objects presented in the dialog box are displayed
in the Message box.

Caution
If a SIDE value is received as “INNER”, it will be rejected and a message will be
displayed explaining the reason for that.

In the case of modified components/mounting holes/ placement obstructs, clicking the
“+” symbol next to a row expands the line to show the original location data for that
component/ mounting hole/ placement obstruct prior to making the change.

Note
Any modification to a component that was not part of the accepted baseline request,
renders this component as a potential addition in the following send requests. i.e. it
appears below the Additions node.

5. If desired, add text or make changes to the rows within the collaboration object changes
area. For example, you could add note text with a short description that would be useful
to your collaboration partner. If you decide not to include some of the changes as part of
the change request, uncheck those rows.

6. Change the name assigned to your transaction file (if desired) and click Send. If you do
not change it, the default transaction file name is changes_00.xml for the first request,
changes_01.xml for the second request, and so on. You cannot use a name for a new
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transaction request if it already exists in the directory you specified when setting up the
ECAD-MCAD Collaborator session.

Clicking Send causes the following message to appear at the bottom of your ECAD-
MCAD Collaboration session:

Sent changes. Awaiting response

Clicking the Send button creates an XML change request file in the directory specified
when you set up the session. Depending on how you set up your ECAD-MCAD
Collaboration session, one of two things can happen:

• If you are using file-based collaboration, the file remains in the directory as an
active request until it is viewed by your collaboration partner. It is up to your
collaboration partner to monitor the shared directory for any new change requests
and act on them as appropriate.

• If you are using email-based collaboration, the ECAD-MCAD Collaborator
generates an automatic email to your collaboration partner with the XML request file
as an attachment. Your partner can then save the request to a local directory before
navigating to that location and showing the request in their ECAD-MCAD
Collaborator session.

The change initiator must now await a response from the change recipient before proposing any
additional changes. Upon sending a change, the Collaborate > Actions > Send Change
Request item is dimmed until the ECAD-MCAD Collaborator detects a response to the
proposal and you acknowledge it (refer to “Processing a Response” on page 35).

Tip: If you know you will not be receiving a response from your collaboration partner,
you can abandon your latest Send Change Request by clicking the Abandon button or
selecting Collaborate > Actions > Abandon to return back from the process response
state to the state where Send Changes is enabled.

Showing and Validating a Change Request
As the change recipient, perform the following steps to show the changes within a proposed
change request and how they impact the design:

1. If not already open, invoke the PCB layout or mechanical design application on the
design and launch the ECAD-MCAD Collaborator.

2. Choose the Collaborate > Actions > Show Change Request pulldown menu item or
corresponding icon. The Show Change Request dialog box appears. Each tab on the
Show Changes dialog shows the collaboration and information data specific to the
object type it holds.
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3. In the Transaction File field of the dialog box, navigate to the location where XML
change files are stored and choose a <change_n>.xml file to open. If you are doing file-
based collaboration, this location is the file location specified in Setup parameters dialog
box. If you are doing email-based collaboration, this is the location where you saved the
request that was attached to the auto-generated email you received.

Once you have navigated to a transaction file to open, the Show Change Request dialog
refreshes to show the collaboration objects’ changes that are part of the change request
(in yellow). The Show Change Request dialog box now appears virtually identical to the
original Send Change Request dialog box (refer to Figure 3-6 on page 27).

Note
If a route border of SIDE value “TOP”, “BOTTOM” or “INNER” is received as an
added/modified route border, it will automatically be flagged as rejected and a response
message will be sent.
On the other hand, when a route border is sent, make sure that the SIDE value is sent as
“ALL”.

4. Click the OK button on the Show Change Request dialog box. The following message
appears at the bottom of your ECAD-MCAD Collaboration session:

Showing changes in Collaborator. Validate the change

You can then use the 3D viewing capabilities to look at the change from various
different viewing angles.

Figure 3-10 shows the top view graphic of an example change request that proposes
moving a component up and to the right of the current location.
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Figure 3-10. ECAD-MCAD Collaborator Window with a Change Showing

5. To see how the change request affects the open design, choose Collaborate > Actions >
Validate Change Request (or the corresponding icon) to apply the change to the
currently open design, where you can then evaluate it further within the context of the
actual design (for example, by running design rule checks).

Once you have evaluated the changes contained in the request and determined their validity,
you send your response back to the change initiator, as described in the next section.

Note
Showing or validating changes does not change the collaboration state. The collaboration
state only changes when a response is sent either accepting or rejecting the changes.
Refer to Responding to a Change Request.

Responding to a Change Request
As the change recipient, perform the following steps to respond to a proposed change request:

1. Show and validate a change request as described in “Showing and Validating a Change
Request” on page 30.
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2. Choose the Collaborate > Actions > Send Response pull-down menu item or
corresponding icon. The Send Response dialog box appears (Figure 3-11).

Figure 3-11. Send Response — Components Tab

Figure 3-12. Send Response — Mounting Holes Tab
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Figure 3-13. Send Response — Placement Obstructs Tab

Figure 3-14. Send Response — Board Obstructs Tab

3. Place a checkmark in the Accept column for those object changes you want to accept
and remove the checkmark for those object changes that you want to reject. Changes
you accept appear in green, while changes you reject appear in red.
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In the above example, the rejection of changing the type of a Route Obstruct from
“Trace” to “Via” will result in placing back the route obstruct 28141 of type “Trace”.
Furthermore, the route obstruct 29120 of type “Via” will always appear as a potential
addition in the subsequent send requests.

In addition, you might want to add additional text in the notes column (especially for
rejected items, explaining why).

For non-component changes, place a checkmark next to the appropriate item in the
Accept other changes area.

4. If desired, rename the transaction file. If you do not change the name, the default is
response_changes_00.xml.

5. Click the Send button. The following message appears at the bottom of your ECAD-
MCAD Collaboration session:

Response sent. Ready to send or receive more changes

The change initiator must now process the response, as described in the next section.

Processing a Response
Once the change recipient has responded to your proposed change request, perform the
following steps to process their response:

1. Choose the Collaborate > Actions > Process Response pull-down menu item (or icon).
The Process Response dialog box appears.

Note that before the change recipient responded to your request, the Process Response
item was dimmed. After the recipient responds to your request, the Process Response
item becomes active.

2. In the Transaction File field of the dialog box, navigate to the location where XML
change files are stored and choose the <response_changes_n>.xml file corresponding
the change request you initiated earlier.

3. View the response.

Note
Add objects that were rejected by the change request recipient will still show up as
potential add objects for future send requests.

4. If you accept the response, click OK. Otherwise, click Cancel and repeat the request
creation process to generate a new request with changes that act as a counter-proposal.

5. The following message appears at the bottom of your ECAD-MCAD Collaboration
session when you click the OK button:

Transaction completed. Ready to send or receive more changes.



ECAD-MCAD Collaborator User’s Guide, V2.336

Using the ECAD-MCAD Collaborator
Sending a Baseline Request during a collaboration session

December 16, 2010

Sending a Baseline Request during a
collaboration session

During a collaboration session, if the design’s current collaboration state is damaged or out of
sync for any reason, EDMD Collaborator allows you to send a baseline request by performing
the following steps:

1. Open the Send Change Request dialog box by doing the same steps in “Sending a
Baseline Request” on page 22.

2. Select the Baseline check box. Notice that the dialog’s name changes to Send Baseline
Request dialog box. Figure 3-15

Once you have selected the baseline checkbox, you are not allowed to select any data.
The baseline send request will include all the data in the current collaboration model at
that time.

Figure 3-15. Send Baseline Request — Components tab

Clicking Send causes the following message to appear at the bottom of your ECAD-
MCAD Collaboration session:

Baseline sent

As a baseline request recipient, perform the same steps in Showing and Responding to a
Baseline Request.
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Figure 3-16. Baseline Add Request — Components tab

Graphically Displaying Requests in Different
States

The items on the Collaborate > Display Requests pull-down menu (and corresponding icons)
visually display the components/ placement obstruct affected by change requests and their
various request states, using the following color coding:

• Accepted changes appear in green

• Rejected changes appear in red

• Changes that still require evaluation appear in yellow

Changes are cumulative. For example, Figure 3-17 shows the graphic display area where
accepted (green) changes are shown. You can then use the 3D viewing capabilities to look at the
change from various different viewing angles.
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Figure 3-17. An Example Graphic with Accepted and Rejected Changes

The highlighted changes remain on the graphic until you clear the changes using Collaborate >
Clear Graphics or the corresponding icon.

Controlling Which States to Display
To control which states to display in the graphic area, choose View > Display Control to show
the display control window and then bring the EDMD tab to the front (Figure 3-18). Checking
an item allows that state to be highlighted in the graphic window, while unchecking an item
prevents that state from being highlighted in the graphic window.

In addition, you can control the color in which the ECAD-MCAD Collaborator displays an item
in the graphic window by selecting the name of the item in the EDMD tab and using the right
mouse button.
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Figure 3-18. EDMD Display Control Tab

Closing the ECAD-MCAD Collaborator
On closing the EDMD Collaborator without saving the changes after a collaboration session
(Creating and Sending a Change Request, Showing and Validating a Change Request and
Processing a Response) a message box is displayed asking whether to save the collaboration
state or not.

This message also appears on reloading the design in either Expedition PCB or Board Station
XE. Below are the changes that cause Expedition to reload the design:

• Moving the board origin

• Renumbering all the RefDes names on electrical components

• Changing the layer stackup

If you click the Yes button, both the collaboration state and the design will be saved. If you click
the No button, the collaboration state will be saved but the design will not. The differences will
appear as potential changes in future Show Changes commands. If you click the Cancel button,
exiting the collaboration will be cancelled and you can continue to where you can exit clearly.
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Third-Party Information

This section provides information on open source and third-party software that may be included in the ECAD-MCAD
Collaborator product.

• This software application may include Xerces 2.7.0 third-party software. Xerces 2.7.0 is distributed under the terms of the
Apache License version 2.0 and is distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either
express or implied. See the license for the specific language governing rights and limitations under the license. You can
view a copy of the license at: docs/legal/apache_2.0_edmd.pdf.  Xerces 2.6.0 may be subject to the following copyrights:

© 1991 by the Massachusetts Institute of Technology

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted
without fee, provided that the above copyright notice appear in all copies and that both thatcopyright notice and this
permission notice appear in supporting documentation, and that the name of M.I.T. not be used in advertising or publicity
pertaining to distribution of the software without specific, written prior permission. M.I.T. makes no representations
about the suitability of this software for any purpose.  It is provided "as is" without express or implied warranty.





End-User License Agreement
The latest version of the End-User License Agreement is available on-line at:

www.mentor.com/eula

END-USER LICENSE AGREEMENT (“Agreement”)

This is a legal agreement concerning the use of Software (as defined in Section 2) and hardware (collectively
“Products”) between the company acquiring the Products (“Customer”), and the Mentor Graphics entity that
issued the corresponding quotation or, if no quotation was issued, the applicable local Mentor Graphics entity
(“Mentor Graphics”). Except for license agreements related to the subject matter of this license agreement which
are physically signed by Customer and an authorized representative of Mentor Graphics, this Agreement and the
applicable quotation contain the parties' entire understanding relating to the subject matter and supersede all
prior or contemporaneous agreements. If Customer does not agree to these terms and conditions, promptly return
or, in the case of Software received electronically, certify destruction of Software and all accompanying items
within five days after receipt of Software and receive a full refund of any license fee paid.

1. ORDERS, FEES AND PAYMENT.

1.1. To the extent Customer (or if agreed by Mentor Graphics, Customer’s appointed third party buying agent) places and
Mentor Graphics accepts purchase orders pursuant to this Agreement (“Order(s)”), each Order will constitute a contract
between Customer and Mentor Graphics, which shall be governed solely and exclusively by the terms and conditions of this
Agreement, any applicable addenda and the applicable quotation, whether or not these documents are referenced on the
Order. Any additional or conflicting terms and conditions appearing on an Order will not be effective unless agreed in
writing by an authorized representative of Customer and Mentor Graphics.

1.2. Amounts invoiced will be paid, in the currency specified on the applicable invoice, within 30 days from the date of such
invoice. Any past due invoices will be subject to the imposition of interest charges in the amount of one and one-half
percent per month or the applicable legal rate currently in effect, whichever is lower. Prices do not include freight,
insurance, customs duties, taxes or other similar charges, which Mentor Graphics will state separately in the applicable
invoice(s). Unless timely provided with a valid certificate of exemption or other evidence that items are not taxable, Mentor
Graphics will invoice Customer for all applicable taxes including, but not limited to, VAT, GST, sales tax and service tax.
Customer will make all payments free and clear of, and without reduction for, any withholding or other taxes; any such
taxes imposed on payments by Customer hereunder will be Customer’s sole responsibility. If Customer appoints a third
party to place purchase orders and/or make payments on Customer’s behalf, Customer shall be liable for payment under
Orders placed by such third party in the event of default.

1.3. All Products are delivered FCA factory (Incoterms 2000), freight prepaid and invoiced to Customer, except Software
delivered electronically, which shall be deemed delivered when made available to Customer for download. Mentor
Graphics retains a security interest in all Products delivered under this Agreement, to secure payment of the purchase price
of such Products, and Customer agrees to sign any documents that Mentor Graphics determines to be necessary or
convenient for use in filing or perfecting such security interest. Mentor Graphics’ delivery of Software by electronic means
is subject to Customer’s provision of both a primary and an alternate e-mail address.

2. GRANT OF LICENSE. The software installed, downloaded, or otherwise acquired by Customer under this Agreement,
including any updates, modifications, revisions, copies, documentation and design data (“Software”) are copyrighted, trade
secret and confidential information of Mentor Graphics or its licensors, who maintain exclusive title to all Software and retain
all rights not expressly granted by this Agreement. Mentor Graphics grants to Customer, subject to payment of applicable
license fees, a nontransferable, nonexclusive license to use Software solely: (a) in machine-readable, object-code form (except
as provided in Subsection 5.2); (b) for Customer’s internal business purposes; (c) for the term of the license; and (d) on the
computer hardware and at the site authorized by Mentor Graphics. A site is restricted to a one-half mile (800 meter) radius.
Customer may have Software temporarily used by an employee for telecommuting purposes from locations other than a
Customer office, such as the employee's residence, an airport or hotel, provided that such employee's primary place of
employment is the site where the Software is authorized for use. Mentor Graphics’ standard policies and programs, which vary
depending on Software, license fees paid or services purchased, apply to the following: (a) relocation of Software; (b) use of
Software, which may be limited, for example, to execution of a single session by a single user on the authorized hardware or for
a restricted period of time (such limitations may be technically implemented through the use of authorization codes or similar
devices); and (c) support services provided, including eligibility to receive telephone support, updates, modifications, and
revisions. For the avoidance of doubt, if Customer requests any change or enhancement to Software, whether in the course of

 IMPORTANT INFORMATION

USE OF ALL SOFTWARE IS SUBJECT TO LICENSE RESTRICTIONS.  CAREFULLY READ THIS
LICENSE AGREEMENT BEFORE USING THE PRODUCTS.  USE OF SOFTWARE INDICATES

CUSTOMER’S COMPLETE AND UNCONDITIONAL ACCEPTANCE OF THE TERMS AND
CONDITIONS SET FORTH IN THIS AGREEMENT.  ANY ADDITIONAL OR DIFFERENT PURCHASE

ORDER TERMS AND CONDITIONS SHALL NOT APPLY.

http://www.mentor.com/eula


receiving support or consulting services, evaluating Software, performing beta testing or otherwise, any inventions, product
improvements, modifications or developments made by Mentor Graphics (at Mentor Graphics’ sole discretion) will be the
exclusive property of Mentor Graphics.

3. ESC SOFTWARE. If Customer purchases a license to use development or prototyping tools of Mentor Graphics’ Embedded
Software Channel (“ESC”), Mentor Graphics grants to Customer a nontransferable, nonexclusive license to reproduce and
distribute executable files created using ESC compilers, including the ESC run-time libraries distributed with ESC C and C++
compiler Software that are linked into a composite program as an integral part of Customer’s compiled computer program,
provided that Customer distributes these files only in conjunction with Customer’s compiled computer program. Mentor
Graphics does NOT grant Customer any right to duplicate, incorporate or embed copies of Mentor Graphics’ real-time operating
systems or other embedded software products into Customer’s products or applications without first signing or otherwise
agreeing to a separate agreement with Mentor Graphics for such purpose.

4. BETA CODE.

4.1. Portions or all of certain Software may contain code for experimental testing and evaluation (“Beta Code”), which may not
be used without Mentor Graphics’ explicit authorization. Upon Mentor Graphics’ authorization, Mentor Graphics grants to
Customer a temporary, nontransferable, nonexclusive license for experimental use to test and evaluate the Beta Code
without charge for a limited period of time specified by Mentor Graphics. This grant and Customer’s use of the Beta Code
shall not be construed as marketing or offering to sell a license to the Beta Code, which Mentor Graphics may choose not to
release commercially in any form.

4.2. If Mentor Graphics authorizes Customer to use the Beta Code, Customer agrees to evaluate and test the Beta Code under
normal conditions as directed by Mentor Graphics. Customer will contact Mentor Graphics periodically during Customer’s
use of the Beta Code to discuss any malfunctions or suggested improvements. Upon completion of Customer’s evaluation
and testing, Customer will send to Mentor Graphics a written evaluation of the Beta Code, including its strengths,
weaknesses and recommended improvements.

4.3. Customer agrees to maintain Beta Code in confidence and shall restrict access to the Beta Code, including the methods and
concepts utilized therein, solely to those employees and Customer location(s) authorized by Mentor Graphics to perform
beta testing. Customer agrees that any written evaluations and all inventions, product improvements, modifications or
developments that Mentor Graphics conceived or made during or subsequent to this Agreement, including those based
partly or wholly on Customer’s feedback, will be the exclusive property of Mentor Graphics. Mentor Graphics will have
exclusive rights, title and interest in all such property. The provisions of this Subsection 4.3 shall survive termination of this
Agreement.

5. RESTRICTIONS ON USE.

5.1. Customer may copy Software only as reasonably necessary to support the authorized use. Each copy must include all
notices and legends embedded in Software and affixed to its medium and container as received from Mentor Graphics. All
copies shall remain the property of Mentor Graphics or its licensors. Customer shall maintain a record of the number and
primary location of all copies of Software, including copies merged with other software, and shall make those records
available to Mentor Graphics upon request. Customer shall not make Products available in any form to any person other
than Customer’s employees and on-site contractors, excluding Mentor Graphics competitors, whose job performance
requires access and who are under obligations of confidentiality. Customer shall take appropriate action to protect the
confidentiality of Products and ensure that any person permitted access does not disclose or use it except as permitted by
this Agreement. Customer shall give Mentor Graphics written notice of any unauthorized disclosure or use of the Products
as soon as Customer learns or becomes aware of such unauthorized disclosure or use. Except as otherwise permitted for
purposes of interoperability as specified by applicable and mandatory local law, Customer shall not reverse-assemble,
reverse-compile, reverse-engineer or in any way derive any source code from Software. Log files, data files, rule files and
script files generated by or for the Software (collectively “Files”), including without limitation files containing Standard
Verification Rule Format (“SVRF”) and Tcl Verification Format (“TVF”) which are Mentor Graphics’ proprietary syntaxes
for expressing process rules, constitute or include confidential information of Mentor Graphics. Customer may share Files
with third parties, excluding Mentor Graphics competitors, provided that the confidentiality of such Files is protected by
written agreement at least as well as Customer protects other information of a similar nature or importance, but in any case
with at least reasonable care. Customer may use Files containing SVRF or TVF only with Mentor Graphics products. Under
no circumstances shall Customer use Software or Files or allow their use for the purpose of developing, enhancing or
marketing any product that is in any way competitive with Software, or disclose to any third party the results of, or
information pertaining to, any benchmark.

5.2. If any Software or portions thereof are provided in source code form, Customer will use the source code only to correct
software errors and enhance or modify the Software for the authorized use. Customer shall not disclose or permit disclosure
of source code, in whole or in part, including any of its methods or concepts, to anyone except Customer’s employees or
contractors, excluding Mentor Graphics competitors, with a need to know. Customer shall not copy or compile source code
in any manner except to support this authorized use.

5.3. Customer may not assign this Agreement or the rights and duties under it, or relocate, sublicense or otherwise transfer the
Products, whether by operation of law or otherwise (“Attempted Transfer”), without Mentor Graphics’ prior written
consent and payment of Mentor Graphics’ then-current applicable relocation and/or transfer fees. Any Attempted Transfer
without Mentor Graphics’ prior written consent shall be a material breach of this Agreement and may, at Mentor Graphics’
option, result in the immediate termination of the Agreement and/or the licenses granted under this Agreement. The terms



of this Agreement, including without limitation the licensing and assignment provisions, shall be binding upon Customer’s
permitted successors in interest and assigns.

5.4. The provisions of this Section 5 shall survive the termination of this Agreement.

6. SUPPORT SERVICES. To the extent Customer purchases support services, Mentor Graphics will provide Customer updates
and technical support for the Products, at the Customer site(s) for which support is purchased, in accordance with Mentor
Graphics’ then current End-User Support Terms located at http://supportnet.mentor.com/about/legal/.

7. AUTOMATIC CHECK FOR UPDATES; PRIVACY. Technological measures in Software may communicate with servers
of Mentor Graphics or its contractors for the purpose of checking for and notifying the user of updates and to ensure that the
Software in use is licensed in compliance with this Agreement. Mentor Graphics will not collect any personally identifiable data
in this process and will not disclose any data collected to any third party without the prior written consent of Customer, except to
Mentor Graphics’ outside attorneys or as may be required by a court of competent jurisdiction.

8. LIMITED WARRANTY.

8.1. Mentor Graphics warrants that during the warranty period its standard, generally supported Products, when properly
installed, will substantially conform to the functional specifications set forth in the applicable user manual. Mentor
Graphics does not warrant that Products will meet Customer’s requirements or that operation of Products will be
uninterrupted or error free. The warranty period is 90 days starting on the 15th day after delivery or upon installation,
whichever first occurs. Customer must notify Mentor Graphics in writing of any nonconformity within the warranty period.
For the avoidance of doubt, this warranty applies only to the initial shipment of Software under an Order and does not
renew or reset, for example, with the delivery of (a) Software updates or (b) authorization codes or alternate Software under
a transaction involving Software re-mix. This warranty shall not be valid if Products have been subject to misuse,
unauthorized modification or improper installation. MENTOR GRAPHICS’ ENTIRE LIABILITY AND CUSTOMER’S
EXCLUSIVE REMEDY SHALL BE, AT MENTOR GRAPHICS’ OPTION, EITHER (A) REFUND OF THE PRICE
PAID UPON RETURN OF THE PRODUCTS TO MENTOR GRAPHICS OR (B) MODIFICATION OR
REPLACEMENT OF THE PRODUCTS THAT DO NOT MEET THIS LIMITED WARRANTY, PROVIDED
CUSTOMER HAS OTHERWISE COMPLIED WITH THIS AGREEMENT. MENTOR GRAPHICS MAKES NO
WARRANTIES WITH RESPECT TO: (A) SERVICES; (B) PRODUCTS PROVIDED AT NO CHARGE; OR (C) BETA
CODE; ALL OF WHICH ARE PROVIDED “AS IS.”

8.2. THE WARRANTIES SET FORTH IN THIS SECTION 8 ARE EXCLUSIVE. NEITHER MENTOR GRAPHICS NOR
ITS LICENSORS MAKE ANY OTHER WARRANTIES EXPRESS, IMPLIED OR STATUTORY, WITH RESPECT TO
PRODUCTS PROVIDED UNDER THIS AGREEMENT. MENTOR GRAPHICS AND ITS LICENSORS
SPECIFICALLY DISCLAIM ALL IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NON-INFRINGEMENT OF INTELLECTUAL PROPERTY.

9. LIMITATION OF LIABILITY. EXCEPT WHERE THIS EXCLUSION OR RESTRICTION OF LIABILITY WOULD BE
VOID OR INEFFECTIVE UNDER APPLICABLE LAW, IN NO EVENT SHALL MENTOR GRAPHICS OR ITS
LICENSORS BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES (INCLUDING
LOST PROFITS OR SAVINGS) WHETHER BASED ON CONTRACT, TORT OR ANY OTHER LEGAL THEORY, EVEN
IF MENTOR GRAPHICS OR ITS LICENSORS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN
NO EVENT SHALL MENTOR GRAPHICS’ OR ITS LICENSORS’ LIABILITY UNDER THIS AGREEMENT EXCEED
THE AMOUNT RECEIVED FROM CUSTOMER FOR THE HARDWARE, SOFTWARE LICENSE OR SERVICE GIVING
RISE TO THE CLAIM. IN THE CASE WHERE NO AMOUNT WAS PAID, MENTOR GRAPHICS AND ITS LICENSORS
SHALL HAVE NO LIABILITY FOR ANY DAMAGES WHATSOEVER. THE PROVISIONS OF THIS SECTION 9 SHALL
SURVIVE THE TERMINATION OF THIS AGREEMENT.

10. HAZARDOUS APPLICATIONS. CUSTOMER ACKNOWLEDGES IT IS SOLELY RESPONSIBLE FOR TESTING ITS
PRODUCTS USED IN APPLICATIONS WHERE THE FAILURE OR INACCURACY OF ITS PRODUCTS MIGHT
RESULT IN DEATH OR PERSONAL INJURY (“HAZARDOUS APPLICATIONS”). NEITHER MENTOR GRAPHICS
NOR ITS LICENSORS SHALL BE LIABLE FOR ANY DAMAGES RESULTING FROM OR IN CONNECTION WITH
THE USE OF MENTOR GRAPHICS PRODUCTS IN OR FOR HAZARDOUS APPLICATIONS. THE PROVISIONS OF
THIS SECTION 10 SHALL SURVIVE THE TERMINATION OF THIS AGREEMENT.

11. INDEMNIFICATION. CUSTOMER AGREES TO INDEMNIFY AND HOLD HARMLESS MENTOR GRAPHICS AND
ITS LICENSORS FROM ANY CLAIMS, LOSS, COST, DAMAGE, EXPENSE OR LIABILITY, INCLUDING
ATTORNEYS’ FEES, ARISING OUT OF OR IN CONNECTION WITH THE USE OF PRODUCTS AS DESCRIBED IN
SECTION 10. THE PROVISIONS OF THIS SECTION 11 SHALL SURVIVE THE TERMINATION OF THIS
AGREEMENT.

12. INFRINGEMENT.

12.1. Mentor Graphics will defend or settle, at its option and expense, any action brought against Customer in the United States,
Canada, Japan, or member state of the European Union which alleges that any standard, generally supported Product
acquired by Customer hereunder infringes a patent or copyright or misappropriates a trade secret in such jurisdiction.
Mentor Graphics will pay costs and damages finally awarded against Customer that are attributable to the action. Customer
understands and agrees that as conditions to Mentor Graphics’ obligations under this section Customer must: (a) notify
Mentor Graphics promptly in writing of the action; (b) provide Mentor Graphics all reasonable information and assistance

http://supportnet.mentor.com/about/legal/


to settle or defend the action; and (c) grant Mentor Graphics sole authority and control of the defense or settlement of the
action.

12.2. If a claim is made under Subsection 12.1 Mentor Graphics may, at its option and expense, (a) replace or modify the Product
so that it becomes noninfringing; (b) procure for Customer the right to continue using the Product; or (c) require the return
of the Product and refund to Customer any purchase price or license fee paid, less a reasonable allowance for use.

12.3. Mentor Graphics has no liability to Customer if the action is based upon: (a) the combination of Software or hardware with
any product not furnished by Mentor Graphics; (b) the modification of the Product other than by Mentor Graphics; (c) the
use of other than a current unaltered release of Software; (d) the use of the Product as part of an infringing process; (e) a
product that Customer makes, uses, or sells; (f) any Beta Code or Product provided at no charge; (g) any software provided
by Mentor Graphics’ licensors who do not provide such indemnification to Mentor Graphics’ customers; or
(h) infringement by Customer that is deemed willful. In the case of (h), Customer shall reimburse Mentor Graphics for its
reasonable attorney fees and other costs related to the action.

12.4. THIS SECTION 12 IS SUBJECT TO SECTION 9 ABOVE AND STATES THE ENTIRE LIABILITY OF MENTOR
GRAPHICS AND ITS LICENSORS FOR DEFENSE, SETTLEMENT AND DAMAGES, AND CUSTOMER’S SOLE
AND EXCLUSIVE REMEDY, WITH RESPECT TO ANY ALLEGED PATENT OR COPYRIGHT INFRINGEMENT
OR TRADE SECRET MISAPPROPRIATION BY ANY PRODUCT PROVIDED UNDER THIS AGREEMENT.

13. TERMINATION AND EFFECT OF TERMINATION. If a Software license was provided for limited term use, such license
will automatically terminate at the end of the authorized term.

13.1. Mentor Graphics may terminate this Agreement and/or any license granted under this Agreement immediately upon written
notice if Customer: (a) exceeds the scope of the license or otherwise fails to comply with the licensing or confidentiality
provisions of this Agreement, or (b) becomes insolvent, files a bankruptcy petition, institutes proceedings for liquidation or
winding up or enters into an agreement to assign its assets for the benefit of creditors. For any other material breach of any
provision of this Agreement, Mentor Graphics may terminate this Agreement and/or any license granted under this
Agreement upon 30 days written notice if Customer fails to cure the breach within the 30 day notice period. Termination of
this Agreement or any license granted hereunder will not affect Customer’s obligation to pay for Products shipped or
licenses granted prior to the termination, which amounts shall be payable immediately upon the date of termination.

13.2. Upon termination of this Agreement, the rights and obligations of the parties shall cease except as expressly set forth in this
Agreement. Upon termination, Customer shall ensure that all use of the affected Products ceases, and shall return hardware
and either return to Mentor Graphics or destroy Software in Customer’s possession, including all copies and
documentation, and certify in writing to Mentor Graphics within ten business days of the termination date that Customer no
longer possesses any of the affected Products or copies of Software in any form.

14. EXPORT. The Products provided hereunder are subject to regulation by local laws and United States government agencies,
which prohibit export or diversion of certain products and information about the products to certain countries and certain
persons. Customer agrees that it will not export Products in any manner without first obtaining all necessary approval from
appropriate local and United States government agencies.

15. U.S. GOVERNMENT LICENSE RIGHTS. Software was developed entirely at private expense. All Software is commercial
computer software within the meaning of the applicable acquisition regulations. Accordingly, pursuant to US FAR 48 CFR
12.212 and DFAR 48 CFR 227.7202, use, duplication and disclosure of the Software by or for the U.S. Government or a U.S.
Government subcontractor is subject solely to the terms and conditions set forth in this Agreement, except for provisions which
are contrary to applicable mandatory federal laws.

16. THIRD PARTY BENEFICIARY. Mentor Graphics Corporation, Mentor Graphics (Ireland) Limited, Microsoft Corporation
and other licensors may be third party beneficiaries of this Agreement with the right to enforce the obligations set forth herein.

17. REVIEW OF LICENSE USAGE. Customer will monitor the access to and use of Software. With prior written notice and
during Customer’s normal business hours, Mentor Graphics may engage an internationally recognized accounting firm to
review Customer’s software monitoring system and records deemed relevant by the internationally recognized accounting firm
to confirm Customer’s compliance with the terms of this Agreement or U.S. or other local export laws. Such review may include
FLEXlm or FLEXnet (or successor product) report log files that Customer shall capture and provide at Mentor Graphics’
request. Customer shall make records available in electronic format and shall fully cooperate with data gathering to support the
license review. Mentor Graphics shall bear the expense of any such review unless a material non-compliance is revealed. Mentor
Graphics shall treat as confidential information all information gained as a result of any request or review and shall only use or
disclose such information as required by law or to enforce its rights under this Agreement. The provisions of this Section 17
shall survive the termination of this Agreement.

18. CONTROLLING LAW, JURISDICTION AND DISPUTE RESOLUTION. The owners of certain Mentor Graphics
intellectual property licensed under this Agreement are located in Ireland and the United States. To promote consistency around
the world, disputes shall be resolved as follows: excluding conflict of laws rules, this Agreement shall be governed by and
construed under the laws of the State of Oregon, USA, if Customer is located in North or South America, and the laws of Ireland
if Customer is located outside of North or South America. All disputes arising out of or in relation to this Agreement shall be
submitted to the exclusive jurisdiction of the courts of Portland, Oregon when the laws of Oregon apply, or Dublin, Ireland when
the laws of Ireland apply. Notwithstanding the foregoing, all disputes in Asia arising out of or in relation to this Agreement shall
be resolved by arbitration in Singapore before a single arbitrator to be appointed by the chairman of the Singapore International



Arbitration Centre (“SIAC”) to be conducted in the English language, in accordance with the Arbitration Rules of the SIAC in
effect at the time of the dispute, which rules are deemed to be incorporated by reference in this section. This section shall not
restrict Mentor Graphics’ right to bring an action against Customer in the jurisdiction where Customer’s place of business is
located. The United Nations Convention on Contracts for the International Sale of Goods does not apply to this Agreement.

19. SEVERABILITY. If any provision of this Agreement is held by a court of competent jurisdiction to be void, invalid,
unenforceable or illegal, such provision shall be severed from this Agreement and the remaining provisions will remain in full
force and effect.

20. MISCELLANEOUS. This Agreement contains the parties’ entire understanding relating to its subject matter and supersedes all
prior or contemporaneous agreements, including but not limited to any purchase order terms and conditions. Some Software
may contain code distributed under a third party license agreement that may provide additional rights to Customer. Please see
the applicable Software documentation for details. This Agreement may only be modified in writing by authorized
representatives of the parties. Waiver of terms or excuse of breach must be in writing and shall not constitute subsequent
consent, waiver or excuse.
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